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1.1    About this manual

1 General information and warnings

1.1 About this manual

This manual is divided into chapters by the chapter number and the large text at the top 
of a page. Subsections are labeled as shown by the 1 and 1.1 headings shown above. 
The names of the chapter and the next subsection level appear at the top of alternating 
pages of the manual to remind you of where you are in the manual. The manual name 
and page numbers appear at the bottom of the pages.

1.1.1 Text conventions

Key names are shown in bold and reflect the case of the key being described. This 
applies to hard keys and onscreen or soft keys.

Displayed messages appear in bold italic type and reflect the case of the displayed 
message.

1.1.2 Special messages

Examples of special messages you will see in this manual are defined below. The 
signal words have specific meanings to alert you to additional information or the relative 
level of hazard.

NOTE: This is a Note symbol. Notes give additional and important information, hints 
and tips that help you to use your product.
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2 Introduction

2.1 Minimum system requirements

To install this software you need a computer with the following minimum specifications:

l PC with Microsoft® Windows ME, 2000, XP

l Pentium III processor @ 700 MHz

l 128 MB RAM

l 20 MB of hard drive space

l CD ROM drive

l RS-232 communication port or USB to serial converter

2.2 Product Introduction

Welcome to the Avery Weigh-Tronix® e-toolsTM software manual. This software makes 
configuration of the EvolutionTM series of indicators and the 1080 indicator a quick, PC 
based operation.

This document is meant to help you understand what this software is capable of and 
how to use it effectively with your 1080 indicator.

The Evolution series of indicators are configurable through the front panel and a menu 
structure built into the indicator’s software. The e-tools program makes this front panel 
configuration unnecessary. 

Easy, on-screen check boxes, drop down lists and data entry boxes make configuration 
quick. When done, you download the file you create to the indicator via RS-232 serial 
cable. The new program overwrites the configuration settings in the indicator with your 
new ones. You can save the configuration file for use on multiple indicators or as a 
backup for your system. You can also upload the configuration of an indicator into the 
program and modify it.

Below is a small list of the items you can enable and configure with this software:

l Capacity

l Division size

l Zero and Motion parameters

l Units of measure

l Serial communication

l Networks

l Applications

l Inputs

l Outputs

l Print formats
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2.3    Starting e-tools

2.3 Starting e-tools

After installation, covered in the Getting Started manual, click on 
START>PROGRAMS>Avery Weigh-Tronix>etools. 

The program will start and you will see the following window:

Choose your indicator model from this drop down box. Currently the only language 
available is English.

Choose 1080 for this manual, then click on the check box to run the program or the X 
to exit.
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The screen is divided into several parts:

The command bar has drop down lists for you to choose from when you click on the 
words.

The tool bar lets you:
l start a new file
l open an existing file
l save a file
l print a file
l open the Options dialog box
l upload a configuration file
l download a configuration file
l choose a communication type (See note at left)

The menu bar contains icons you can click on to show the configuration items for your 
indicator.

The Communications Type drop down box lets you select serial communications, 
single ethernet device or ethernet network downloads. Ethernet communications 
allows for downloading of configuration data only.

The configuration window will show the current configuration items to be set.

The status bar at the bottom of the window shows the status of several keyboard keys 
and the current date and time.

Those items needing further explanation are explained in detail in the following 
sections.

Command Bar
Communications type

Tool Bar

Site Selector

Model

Configuration Window

Status Bar

Menu Bar

If you click on the Avery 
Weigh-Tronix logo, the 
AWT web site will open.
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2.4    Command Bar

2.4 Command Bar

The command bar has the following commands:

2.4.1 File

If you click File the following drop down menu appears:

2.4.2 View

If you click View the following drop down menu appears:

2.4.3 Tools

If you click Tools the following drop down menu appears:

From this list you can:

l create a new file

l open an existing file

l close an open file.

l upload a configuration file from an indicator

l download a configuration file to an indicator

l save an open file

l save an open file under a different name

l setup the printing or a configuration report

l print a configuration report

l choose from a list of recent files

l clear recent file list

l close the program

l Click Toolbar to toggle the toolbar on and off

l Click Status Bar to toggle the status bar on and off

l Click here to open the Options dialog box

l Click here to print a configuration report
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2.4.4 Help

If you click Help the following drop down menu appears:

2.5 Menu Bar

As you click on each menu bar item, the related icons appear. All four menu items are 
shown below. Each icon will be covered in the Configuration section of this manual.

l Click here to open the user’s manual (PDF)

l Click here to see software information
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2.6    Configuration Window

2.6 Configuration  Window

When you click on a menu bar icon, the related configuration dialog box appears in the 
configuration window. Below is an example:

It is in these dialog boxes that you choose all the configuration parameters for your 
indicator and scale setup.

When all your parameters are set, connect your PC to the indicator and click the 
download (down arrow) button on the button bar. The file is sent to the indicator via 
configured communications type and all the new parameters take effect.

2.6.1 Entering Values

When you key in values, the software validates the entry so that you cannot enter an 
incorrect value. For example, if a percentage rate (say 0-100) is required, and you key 
in 123, then the value will be highlighted and you will not be able to tab to the next input 
box until the value is corrected. This will also occur if you enter an invalid character, 
such as '12w' instead of '123'.

You can either edit and correct the value or (while the entire value is highlighted) you 
can press the DELETE key on the PC keyboard and start over. If the entry box is 
completely clear and you tab to another box, the default value for that item will 
automatically be inserted in the box.
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3 Creating and Saving a Configuration File
The steps you take to create a new configuration file are:

l set the defaults

l configure all scale/indicator parameters

l save the file

Downloading the file is in the next section.

3.1 Setting the Defaults

Use this item, in  the upper right corner of the program window, to choose your 
instrument location; NA (North America), EU (Europe). Choosing the correct one will 
set defaults to your location’s requirements.

You must perform the following to load default print strings and to create a 
downloadable configuration file.

1. Click on FILE>OPEN…

The following appears: 

2. Click No…

A Select Configuration File dialog box appears.

You can edit an existing file by opening the file, making the desired changes and 
saving the file.
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3.1    Setting the Defaults

3. Navigate to the Default Config Files folder shown below: 

 

and select that folder…

The following choices appear: 

4. Select defaultEU.1080 or defaultNA.1080. This should match your Site choice 
made at the beginning of this section, 3.1.

5. Select File>Save As and save the file to the User Config Files folder. The path 
is shown below. You can save file with any name you want.

6. When you press File>Save, this is where the information will now be stored.

The default NA.1080 and defaultEU.1080 files are locked as read only. Your file 
needs to be saved as a different file in order for it to download to the 1080. This is 
done to guarantee a clean and usable file for factory reload.
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7. You now have a downloadable file for the indicator.

3.2 Setting Options

Click on Tools>Options to see the General tab shown below:

3.2.1 General tab

In the this window you can enable or disable the following options:

Beeper This is a PC warning beep when an error is detected.
Sound Effects These are the sounds made as you navigate the e-tools 

program.
Load last… If enabled, the last saved file will open when the e-tools 

program is started.
Allow selection… If enabled you can select a firmware bootloader under the 

Firmware menu bar item.

Prevent Screen… This will disable the screensaver to stop it from interrupting the 
download process.

3.3 CONFIGURING - Configuration Button

Under the Configuration button on the menu bar there are six icons:

l Scale, see Scale Icon on page 17
l Applications, see Application Icon on page 25
l Serial, see Serial Icon on page 37
l Analog out, see Analog Output Icon (requires indicator option) on page 39
l Trips, see Trips Icon on page 40

Each is explained on the following pages.

It is always a good idea to save your file often as you set the various items in e-tools.
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3.3    CONFIGURING - Configuration Button

3.3.1 Scale Icon

Click on the Scale icon, shown above, and the following dialog box appears:

The dialog box has several tabs. Each tab is explained below.

Calibration tab
Under the Calibration tab, type in, select or enable the following items:

Capacity Type in the scale capacity.

Weight Type in the calibration test weight size

Calibration Units Choose lb or kg as the calibration unit of measure

Division Type in the division size of your displayed weight. Choices 
are: 1, 2, 5, 10, 20, 50, 100, 200, and 500

All of these capacities function in conjunction with the decimal place position. For 
example, if you choose a division size of 5 and a decimal position of 12345.6, your 
division size will be .5.
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Decimal Pos. Pick a decimal position from the drop down list. Choices available 
are; 123456, 12345.6, 1234.56, 123.456, 12.3456 and 1.23456. 
See illustration below:

Decimal position works with Division size. Pick a division size then 
the decimal position to get the displayed division size.

Weight Source Choose if your scale is analog or SensorComm.

If you choose SensorComm, the following appears in the window:

You must enable the sensors which will be used by SensorComm. 
You may also enable ghosting which allows the scale to function 
in certain situations with 1 or more weight sensors out of 
operation. See the SensorComm manual for complete 
information.

When using a scale with SensorComm, always start with B1 and continue 
consecutively, i.e. B2, B3, etc.
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Units Enabled Enable the units of measure you want available when you click on 
the indicator’s UNITS key. The shaded unit under Units Enabled 
is a result of the selection in Calibration Units.

If Custom is checked under Units Enabled, the dialog box changes 
to this:

Custom Units Type a name for the custom unit of measure. Type in a conversion 
factor based on the primary or calibration unit of measure. See the  
note below.

If your new custom unit is larger than one CAL UNIT, then you key in how many CAL 
UNITS make up 1 new custom unit. For example 1 TON = 2000 pounds so with 
pounds selected as our CAL UNIT we would key in 2000 for the multiplier. 

 
If your new custom unit is smaller than one CAL UNIT, then you divide one cal unit by 
the number of custom units it takes to make up a single CAL UNIT. Multipliers are 
limited to a total of seven digits by the display. 
 
Example #1: 16 ounces = 1 pound.  
Do the math: (one cal unit / number of custom units = the multiplier) 1/16=0.0625 
So with pounds selected as our CAL UNIT we would key in 0.0625 for the multiplier. 
 
Example #2:  
1000 Grams = 1 KG.  
Do the math: 
(one cal unit / number of custom units = the multiplier) 1/1000=0.001 
So with KG selected as our CAL UNIT we would key in 0.001 for the multiplier.
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Zero/Motion tab
The following is displayed when you click on the Zero/Motion tab.

Under the Zero/Motion tab, set the following:

Zero Range Type in a percentage of capacity, within which the ZERO 
key will zero the scale.

Center Zero Range Select a window size for the center-of-zero annunciator. 
You can choose between ±¼ and ±½ division of zero 
weight. When the weight falls within the window size, the 
center-of-zero annunciator lights.

Gross Zero Band This is a parameter used to trigger the tare clear function 
covered under the Tare tab. You can select values 
between 0 and 100 divisions.

Auto Zero Tracking Type in a division size and time delay in seconds. The 
division size you pick defines a range above and below 
zero. When scale weight is inside this range for the 
number of seconds you picked, ½ of the weight will be 
zeroed. The indicator will repeat removing ½ the weight 
every X seconds. X being the number of seconds you 
have picked. See the note below.

Motion Type in a division size and time delay in seconds.  This 
defines the stability window in terms of ±divisions for a 
period of time, in seconds. If a weight changes less than 
this number of divisions in the time period you select, the 
motion light turns off and the weight is considered stable. 
See note at left.

AZT and Motion 
Common Division selections: 0.25, 0.5, 1.0, 2.0, 3.0
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3.3    CONFIGURING - Configuration Button

Tare/E-Mail tab
The following is displayed when you click on the Tare/E-Mail tab:

Here you can set the following:

Pushbutton Tare If you enable this item you can use the TARE key to tare 
a weight from the scale. If you disable this item, you 
cannot tare using the TARE key.

Auto Tare Clear If you enable this item the tare clears automatically when 
the weight falls below the value set under Gross Zero 
Band discussed on the previous page.

Auto Tare Enable Select this to enable the Auto Tare function. If enabled 
you will see these additional items: 

Auto Tare Print Select this and a print function will occur 
whenever an automatic tare is done. The 
formats chosen for the current application 
will print when the auto tare print occurs or 
when the PRINT key is pressed.
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Auto Tare Lower &
Upper Limit These are the lower and upper thresholds 

that define the automatic window. They are 
both entered as a percentage of capacity. 
When the net weight on the scale is: 
• above the lower threshold and 
• below the upper threshold and 
• the delay (explained below) has expired 
• and weight is stable 
an auto tare is triggered. See the note 
below.

Auto Tare Delay Enter this value in seconds. This is the 
amount of time after the weight falls into the 
auto tare window until an auto tare is done.

Send Email When: Select any or all instances when an email notice is sent by 
the indicator. Email is setup in the Net Manage window.

System tab
The following is displayed when you click on the System tab:

Auto Print Enable Use this item to set a minimum weight under which the 
indicator will send out the configured print format. This is 
a percentage of scale capacity.

Error Indicator Choose the function that is associated with the bottom 
LED error indicator on the display. Choices are Off, 
SensorComm, Network-1 or Network-2.

Setting the lower or upper limit to zero disables the auto tare feature.
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Deadload Enable If you enable this, the Deadload choices appear in the 
bottom right of the window. Use these items to choose a 
percentage of scale capacity at which the scale gives a 
warning or causes an error. This is used if SensorComm 
is enabled.

Display Update Rate Set the display update rate. Choices are 
1, 2, 5, 10 Hz.

Separators Pick a decimal point or a comma for the 
fraction delimiter for the display. For 
example, if you pick Decimal, the display 
will show 10.5. If you pick Comma, the 
display will show 10,5.

Time/Date Format Time Choices are 12 hour (AM/PM) or 24 hour 
format.

Date Select the style of date display. Choices 
are shown below:

Filter tab
Click the Filter tab and the following is displayed.

Averages Set the number of A to D counts to be averaged for display or 
printed weight. Choose values between 0 and 128 from the drop 
down list.

Filter enable Choose Disabled to disable filtering or choose Single Pole or 
Three Pole filtering
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.

Three-pole filtering is faster response to weight in a short time.

Single-pole, passive filtering is slower response to weight in a 
longer time period with improved accuracy.

Filter settings If you enable filtering Filter Settings appears. For the Constant 
value you can pick a value between 1 and 10. Set the number low 
for small vibration problems and higher for more dampening 
effect. 
 
The Threshold Weight parameter causes the indicator to respond 
quickly to large weight swings. Threshold is the amount of weight 
swings, in calibration units, beyond which the filtering will be 
temporarily disabled. For example, if you set this to 10 lbs, a 
weight swing greater than 10 pounds occurring during the sample 
time will disable the filtering until the weight swings during the 
sample time is less than 10 lbs.
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Ranges tab
Click the Range tab and the following is displayed:

Use this item to set the point at which under range (lower) dashes or over range (upper) 
dashes are displayed. You can choose between 105% of capacity or +9/-20 divisions 
over/under capacity. See the list below:

This completes the Scale section of the configuration.

3.3.2 Application Icon

Click the Application icon, shown above, on the Menu Bar and the following window 
appears:

The tabs give you access to each application which you can enable. If enabled, some 
applications may have more settings. Each are discussed below.
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General Weighing tab
General weighing is the first tab that appears since it is the default application on the 
1080. It is enabled automatically since it is the default application. 

Choose Print Format(s):
Type in the print formats (0-10) that you want printed when the PRINT button is pressed 
during normal operation. Multiple print formats must be typed in ascending order.

For example: Enter 0123410 and print formats 0, 1, 2, 3, 4 and 10 are sent out the serial 
port.

Accumulator tab
Click on the Accumulator Tab. Enable this application by clicking on the Enable button.

Choose Print Format(s):
Type in the print formats (0-10) that you want printed when the PRINT button is pressed 
during normal operation. Multiple print formats must be typed in ascending order.

For example: Enter 0123410 and print formats 0, 1, 2, 3, 4 and 10 are sent out the serial 
port.



1080 e-tools User Instructions 27

3.3    CONFIGURING - Configuration Button

Batching tab
Click the Batching tab and select Enable Batching Applications. The following choices 
will appear:

Choose Print Format(s):
Type in the print formats (0-10) that are to be printed when the PRINT button is pressed 
during normal operation. Multiple print formats must be typed in ascending order.

For example: Enter 0123410 and print formats 0, 1, 2, 3, 4 and 10 are sent out the serial 
port.

Select Automatic, Manual, Filling, Continuous or Reverse Filling Mode: 

Manual If the recipe is set up for Manual mode, you press the F1 key to 
start the batch and you need to press the F1 key each time a 
output is reached to activate the next ingredient output.

Automatic If the recipe is set up for Automatic mode, you press the F1 key to 
start the batch and each output is activated and deactivated 
automatically by the indicator.
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Filling In Fill mode, any recipe that has been setup is ignored. The filling 
process is run based on the values set for the outputs. In order to 
complete the filling process, at least one output must be enabled. 
If you select this mode you are given two Fill Type choices: 
Absolute and Relative. See the graphic below. 

Absolute Choose this mode and setpoints activate when the F1 
key is pressed. When the net weight on the scale 
reaches the configured setpoint value, the setpoint 
will deactivate.

Relative Choose this mode and when you press the F1 key the 
starting weight is captured and the sepoints activate. 
The setpoint will not deactivate until the net weight on 
the scale reaches the starting weight plus the 
configured setpoint value.

Continuous Continuous batching mode. This mode is very close to the Auto 
mode. In continuous mode, another batch is started immediately 
after the previous batch has finished. In Auto mode, the user must 
press the F1 key to start each batch.

Reverse Fill Reverse fill batching mode. This is similar to the Filling mode. 
However, the weight on the scale must be above the configured 
setpoint weight when you press the F1 key in order for the setpoint 
to be activated. When the weight on the scale decreases enough 
to fall below the configured setpoint value, the setpoint will 
deactivate. If you select this mode you are given two Fill Type 
choices: Absolute and Relative. See the graphic below. 

Absolute Choose this mode and setpoints activate when the F1 
key is pressed. When the net weight on the scale 
reaches the configured setpoint value, the setpoint 
will deactivate.

Relative Choose this mode and when you press the F1 key the 
starting weight is captured and the sepoints activate. 
The setpoint will not deactivate until the net weight on 
the scale reaches the starting weight plus the 
configured setpoint value.
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Select Recipe Number:
The 1080 allows only one recipe so the drop down list contains Recipe 0 only. When 
you select this number, the following appears in the window:

You can now create a recipe using this Recipe area of the screen. 

Choose Type of Recipe:

Constant Batches are all the same size and the weight of each ingredient is 
predetermined by the recipe.

Percentage Batch size is chosen by the operator and each ingredient is 
determined by the percentage set in the recipe.

Gross You set the gross weight at which each ingredient will stop. The 
ingredient is complete when the gross weight on the scale reads 
the value that was set, regardless of the weight on the scale when 
the batch was started.

Enable or disable the Preact: 

A preact is the time it takes an ingredient (which is falling from an auger or other feeder) 
to reach the scale after the auger or feeder is shut off. There will always be material in 
“free-fall” after an ingredient is shut off and the indicator will automatically calculate this 
and update this value.

The first time a batch is run, overage for any ingredient weight is calculated and the 
next time the ingredient is being weighed the output will be shut down so approximately 
70% of the overage is reduced. This occurs each time a batch is run so that the system 
quickly learns and produces accurate batches.

Define the ingredients:

To define an ingredient you:

l Choose an ingredient #.
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l Choose the basis for the ingredient:

The Basis of each ingredient can be weight or time.

Scale If an ingredient basis is scale weight, the output 
activates at the appropriate time and deactivates when 
the weight set in the recipe is reached.

Time If an ingredient basis is time, the output activates for the 
time set in the recipe and then deactivates.

l Choose an Output: Set the output you want associated with the ingredient. 
Choices are 1, 2 , 3 or None.

l Choose a Delay: Set a time delay between when a basis is met and the next 
ingredient action is started.

Checkweigher tab
Click the Checkweigher tab and select Enable Checkweigher Application. The 
following choices will appear:

Choose Print Format(s):

Type in the print formats (0-10) that are to be printed when the PRINT button is pressed 
during normal operation. Multiple print formats must be typed in ascending order.

For example: Enter 0123410 and print formats 0, 1, 2, 3, 4 and 10 are sent out the serial 
port.

Choose Outputs:
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Configure Outputs: Choose between Standard, Target1 and Target2.

STANDARD: Trips are configurable outputs.  An output value can be 
entered in weigh mode of operation.

TARGET (latched): Latched outputs.  When weight is added to the scale, 
the appropriate trip; OP1, OP2 or OP3, activates.  The 
trip is now activated, and will remain active, until the 
scale returns to gross zero.

TARGET (unlatched): Unlatched outputs.  When weight is added to the scale, 
the appropriate trip; OP1, OP2 or OP3, activates.  The 
trip will deactivate when weight decreases below the 
configured trip.

Choose Mode:

Limits Mode In this mode the user enters the upper and lower limits for the item 
and the indicator will use those values to run the display.

Sample Mode If you pick Sample Mode, the Target Window box, shown below, 
appears in the dialog box. 

In Sample mode the user places a correct weight “product” on the 
scale and presses the F1 key. The indicator will use this weight to 
run the display. Upper and lower limits will automatically be one 
division above and below the target weight respectively, by 
default. This default vaule can be changed using the Target 
Window, shown above. Type in a target division size other than 
the default, 1.

The ACCEPT annunciator stays lit if weight is within the upper and 
lower limits.

Choose Statistics:

Outputs 1, 2 and 3 must be turned on for the checkweighing annunciators (Over, 
Accept, Under) to work.
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If the statistical features are enabled, the user is to enter a sample size after the over 
and under targets are set. Each time the gross weight on the scale goes above 10 
divisions and the weight stabilizes, the weight is captured and added to the statistical 
data. The gross weight on the scale must return to the center of zero before another 
weighment can be captured.

Disabled Choose this to disable statistics colleciton.

XBar-R Choose this and the average weight of each complete 
sample set is stored. The 1080 will keep a queue of the 
average weights of the last 8 sample sets. This queue of 
averages is used to print trend information on the statistical 
reports.

Standard Deviation Choose this to enable the collection of standard deviation 
data.

Both Choose this enable the collection of both XBar-R and 
Standard Deviation statistics.

If you choose XBar-R, Standard Deviation or Both, the following items appear:

Statistical Printout Choose the port through which the statistical 
information will print.

Print Stats on Keypress Choose this to cause the statistical information to 
print when the PRINT key is pressed.

Auto-Print Each Weighment When enabled, each sample weighment is 
printed as it is captured. The range of the sample 
(over, under or accept) is also printed.

Auto-Print Stats When enabled, the statistical information will be 
automatically deleted after the report is printed.
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Counting tab
Click the Counting tab and select Enable Counting Application. The following choices 
will appear:

Choose Print Format(s):

Type in the print formats (0-10) that are to be printed when the PRINT button is pressed 
during normal operation. Multiple print formats must be typed in ascending order.

For example: Enter 0123410 and print formats 0, 1, 2, 3, 4 and 10 are sent out the serial 
port.

Choose a Sample Mode:

Bulk sampling In this sampling method you place the specified sample 
number  of items on the scale all at once (in bulk) and after 
motion stops, the scale automatically starts to calculate piece 
weight and then shows the count.

Dribble sampling In this sampling method you can count out the specified 
sample number of items onto the scale and when you are 
ready, press the F1 key and after motion stops, the scale 
starts to calculate piece weight and then shows the count.

Choose the Sample Minimum Weight and the Sample Size:

Set the minimum sample weight as a percent of capacity that the sample must weigh.

Set the default sample size to prompt the operator to place on the scale.
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Peak-Hold tab
Click the Peak-Hold tab and select Enable Peak-Hold Application. The following 
choices will appear:

Choose Print Format(s):

Type in the print formats (0-10) that are to be printed when the PRINT button is pressed 
during normal operation. Multiple print formats must be typed in ascending order.

For example: Enter 0123410 and print formats 0, 1, 2, 3, 4 and 10 are sent out the serial 
port.

Remote Display tab
Click the Remote Display tab and if you enable it you will see the following choice:

Choose Print Format(s):

This section for future use

Choose Remote Display Mode:

Mode-1 The indicator acting as the remote display will show the Gross or Net 
annunciator and the characters displayed on the master indicator. 
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Mode-2 The remote display will show the Gross or Net annunciator, the 
characters and all annunciators displayed on the master indicator.

Mode-3 The remote display will show the Gross or Net annunciator, the 
characters displayed on the master indicator and allows zeroing of the 
scale from the remote.

Mode-4 The remote display will show the Gross or Net annunciator, the 
characters and annunciators displayed on the master indicator and 
allows full function of all the keys on the remote.

Choose a Port: Choose which port, 1 or 2,  serial information is coming into.

Axle (Split) tab
Click the Axle (Split) tab and if you enable it you will see the following choice:

This application allows the 1080 to capture truck axle weights. The scale must be short 
enought so that the scale becomes empty between axles.

Choose Print Format(s):

Type in the print formats (0-10) that are to be printed when the PRINT button is pressed 
during normal operation. Multiple print formats must be typed in ascending order.

For example: Enter 0123410 and print formats 0, 1, 2, 3, 4 and 10 are sent out the serial 
port.

Choose Axle Threshold and Timeout:

Axle Threshold This is the minimum weight for an axle in divisions. When the 
weight goes above this threshold the 1080 can turn a 
connected traffic light red and waits for the weight to stabilize.
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Axle Timeout This is the maximum time, in seconds, between axles. After an 
axle is weighed, the next axle must come onto the scale within 
the timeout period. If the timeout expires before the next axle 
is on the scale, the 1080 assumes this was the last axle and 
prints the axle total.

This concludes the Application Icon section.
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3.3.3 Serial Icon

Click the Serial icon on the Menu Bar and the following window appears:

In this window you set up the serial communication parameters for Port 1 and Port 2. 
Choose the port and then select values for each item from its drop down list.

Baud Rate Choose from 300 to 115200

Data Bits Choose from 7 or 8

Parity Choose from None, Odd or Even

Handshake Choose from None, RTS/CTS or Xon/Xoff. (RTS/CTS not 
available for Port 1)

Mode Depending on the mode you pick, a secondary choice may 
appear. All are explained below:

Broadcast Causes a Print Format box and Rate box to appear. 
Choose Broadcast to cause the configured print 
format(s) to be sent out the serial port continuously 
at the rate chosen when there is no motion on the 
scale

You must type in the print format numbers in ascending order. 
 
For example: Enter 0123410 and print formats 0, 1, 2, 3, 4 and 10 are sent out the 
serial port.
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Enquire Causes a Print Format box and Polling Character 
box to appear. Choose the polling character which 
when received by the indicator will cause the print 
format(s) to be sent through the serial port. The 
polling character can be any ASCII code # from 0 to 
255 (hex 00 to FF).

SMA Choose from the Scale Manufacturer’s Association 
list of commands and responses.

RD4100 Like Broadcast except it will send information even 
when the scale is in motion. If you pick format #0, a 
default G XXXXXX lb format will be sent.

RD Mode 1 Select this to send G XXXXXX lb at the rate you pick 
in the Rate box.

RD Mode 2 Select this to send the same as RD Mode 1 + 
annunciators

RD Mode 3 Select this to send the same as RD Mode 1 + will 
accept the keys presses from the remote (TARE, 
SELECT, ZERO, PRINT, UNITS)

RD Mode 4 Select this to send the same as RD Mode 2 + 
accepts the keys presses from the remote (TARE, 
SELECT, ZERO, PRINT, UNITS)

RS-485 When you choose this a Muli-drop Address box 
appears. The address can be any ASCII code # 
from 0 to 255 (hex 00 to FF).

485 Half Duplex When you choose this a Muli-drop Address box 
appears. The address can be any ASCII code # 
from 0 to 255 (hex 00 to FF).

There are also two checkboxes:

Use Leading Zeros Leading zeros fill in any open spaces before a weight 
value in a printout

Enquire Motion If checked, the scale will respond to an enquire code only 
when there is no motion on the scale.
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3.3.4 Analog Output Icon (requires indicator option)

Click the Analog Output icon, shown above, on the Menu Bar. If you enable analog 
output the following is displayed:

Set the “Basis”:

Choose what the output will be based on; Gross Weight or Net Weight

Set the “Weight for Analog Output”:

For Example: The minimum weight is 0 pounds and the maximum weight is 5000 lbs. 
This represents the minimum 4mA output at 0 pounds and the maximum 20mA output 
at 5000 lbs.

Set the “Output Adjustment”:

For Example: Increasing the offset amount above 0% will increase the 0 weight value. 
Increasing the span percentage will increase the maximum weight value. Both of these 
adjustments increase the voltage from the physical card.
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3.3.5 Trips Icon

Click the Trips icon. Use this to enable and assign key functions to specific inputs and 
to enable or disable outputs. Below is a sample of all inputs enabled and an action 
assigned to each input. See list of choices in the note below.

When you click the Outputs tab you are shown three checkboxes for the three outputs. 
See example below. Click on the checkbox for the output you want to enable. Click 
again to disable an output.

Choice Input Action 
None No action 
F1_Key Remote F1 
Tare Remote TARE key 
Units Remote UNITS key 
Print Remote PRINT key 
Zero Remote ZERO key 
Tare Cancel Clear active tare 
Start Starts batch in batch mode 
Stop Stops batch in batch mode
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3.4 CONFIGURING - Printer Button

When you click the Printer button in the Menu Bar and then click the Print Format icon 
you will see the screen shown below. Use this window to create and save custom print 
formats.

See the note below for information regarding print formats for each application.

Print Format 0 is the default print format reserved for each application mode. 
 
Formats 1-9 are available for any application mode.  
 
Format 10 = Format 0 for the General Weighing application. 
Format 11 = Format 0 for the ACC application. 
Format 12 = Format 0 for the Batch application. 
Format 13 = Format 0 for the Target application. 
Format 14 = Format 0 for the Count application. 
Format 15 = Format 0 for the Top application. 
Format 16 = Format 0 for the Remote Display application. (unused) 
Format 17 = Format 0 for the Enquire mode on serial port 1. 
Format 18 = Format 0 for the Broadcast mode on serial port 1. 
Format 19 = Format 0 for the RD4100 mode on serial port 1. 
Format 20 = Format 0 for the Enquire mode on serial port 2. 
Format 21 = Format 0 for the Broadcast mode on serial port 2. 
Format 22 = Format 0 for RD4100 mode on serial port 2. 
Format 23 = Format 0 for the General Weighing application.
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Click on the New File icon to start a new print format.

 The screen should look similar to this:

The print format command bar is illustrated below with explanations for the functions of 
each.

* Print format cannot be edited when Show Tokens is selected.

Editing Window ENTER key function can be changed. 
Select Edit command to modify.

Edit command duplicates what these keys
do plus assigns default insert 
when ENTER key is pressed

on your keyboard 

Opens a new
format

View commen duplicates what 
these two keys do

Cut Copy Paste Inserts
selected

term 

Move
insert

pointer  to
end

Show
strings

Show
tokens*
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3.4.1 Creating a Print Format

To create a print format, follow these steps:

1. Choose a format # from the drop down list above the editing window.

2. Type a print format name in the Name window.

3. Pick a port to use when printing the format.

4. Click on Edit>Enter Key. . .and select what pressing the ENTER key on the 
keyboard will insert. See illustration below.

5. Insert the text cursor in the editing window by clicking anywhere in the window.

6. Expand the terms list by clicking on the plus (+) symbol.

7. Double click a term to insert it at the cursor position or click on a term and click 
the Insert Term button.



 44 1080 e-tools User Instructions

3   Creating and Saving a Configuration File

8. Press the ENTER key when necessary to enter the carriage returns and/or line 
feeds you picked in step 4. See sample below:

9. When you are finished laying out the look of the format you can go to the next 
format you want to create or continue with creating your configuration file.

Print Format 0 is the default print format reserved for each application mode. 
 
Formats 1-9 are available for any application mode.  
 
Format 10 - Format 0 for the General Weighing mode 
Format 11 = Format 0 for the ACC mode 
Format 12 = Format 0 for the Batch mode 
Format 13 = Format 0 for the Target mode 
Format 14 = Format 0 for the Count mode 
Format 15 = Format 0 for the Top mode
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3.5 CONFIGURING - Net Manage Button

When you click the Net Manage button, shown at left, and the Fieldbus-1 icon in the 
Menu Bar you will see the screen shown below. Use this window to configure your 
network connections, if any.

You can choose from Fieldbus-1 or Fieldbus-2. With either of these you can configure 
the networks shown in the illustration below:

Pick the network from the drop down list and the appropriate boxes will appear and/or 
appropriate tab(s) will activate. Follow the steps in the next pages to configure each 
network.

These files are needed to configure the PLC so it will communicate to the 1080 
indicator: 
PROFIBUS® - AWTX0913.GSD 
DeviceNetTM - 1080_Dnet_EnetIP.EDS 
EtherNet-3 (EtherNet/IPTM) - 1080_Dnet_EnetIP.EDS 
 
These files can be found in the etools folder on your hard drive. Typically this is 
C:\program files\avery weigh-tronix\etools suite\etools(10xx)\networks
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3.5.1 DeviceNetTM  

Click on DeviceNetTM in the drop down list to configure a DeviceNet network. The 
window looks like this:

Select Indicator node:
Key in the node for the indicator. Acceptable values are 0 to 63.

Select Baud Rate:
Select a baud rate for network communications. Available choices are 125K, 250K and 
500K.

Click the Map Data tab and the following is displayed:

3.5.2 PROFIBUS®  

Click on PROFIBUS® in the drop down list to configure a PROFIBUS®  network. The 
window looks like this::

Select Indicator node:
Key in the node for the indicator. Acceptable values are 0 to 63.

Click the Map Data tab and the following is displayed:

Valid nodes for DeviceNet
are 0 to 63.

Valid nodes for DeviceNet
are 0 to 63.
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This shows the 
“spacing” of each piece 
of data as it will show 

up on the PLC.

Click here for a 
dropdown list of 

network tokens. See 
Appendix B for full list.

Click here for a 
dropdown list of Data 

Types.

This shows the total number 
of bytes used by the indicator. 
This information is required 

by the PLC programmer and 
is automatically calculated.

Click here to 
trade/swap the

word order

Choose Endian 
Format (Big or 

Little) here.

Choose to create 
the Inbound Data 
Map or Outbound 

Data Map by 
selecting your 
choice here.

Data Type Type # Data # of Bytes Range of Value

S8 0 Signed Char. 1 -127 to 127

U8 1 Unsigned Char. 1 0 to 255

S16 2 Signed Integer 2 -32767 to 32767

U16 3 Unsigned Integer 2 0 to 65535

S32 4 Signed Long 4 -2,147,483,647 to 2,147,483,647

U32 5 Unsigned Long 4 0 to 4,294,967,295

FLOAT 6 Float 4 1.0E-37 to 1.0E37

This shows the 
“spacing” of each piece 
of data as it will show 

up on the PLC.

Click here for a 
dropdown list of 

network tokens. See 
Appendix B for full list.

Click here for a 
dropdown list of Data 

Types.

This shows the total number 
of bytes used by the indicator. 
This information is required 

by the PLC programmer and 
is automatically calculated.

Click here to 
trade/swap the

word order

Choose Endian 
Format (Big or 

Little) here.

Choose to create 
the Inbound Data 
Map or Outbound 

Data Map by 
selecting your 
choice here.

Data Type Type # Data # of Bytes Range of Value

S8 0 Signed Char. 1 -127 to 127

U8 1 Unsigned Char. 1 0 to 255

S16 2 Signed Integer 2 -32767 to 32767

U16 3 Unsigned Integer 2 0 to 65535

S32 4 Signed Long 4 -2,147,483,647 to 2,147,483,647

U32 5 Unsigned Long 4 0 to 4,294,967,295

FLOAT 6 Float 4 1.0E-37 to 1.0E37
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3.5.3 EtherNet-1 (IT)

Click on EtherNet-1 (IT) in the drop down list to configure a EtherNet-1 (IT) network. 
The window looks like this:

Indicator IP Address:
Key in the IP address for the indicator. If you enable DHCP (Dynamic Host 
Configuration Protocol), the IP address for the indicator is not required.

Download Port:
Key in the network port used to download the configuration changes via Ethernet.

Select Ethernet Addresses:
Key in the IP address for the host IP, SMTP, Gateway, Subnet and key in the port 
number that the indicator and the remote host will be connected on.

Set Socket Mode:
SMA The SMA protocol over the Ethernet connection.  This is the exact same 

protocol used on the serial ports.  See the Service-Serial section of the 
Model 1080 Service Manual for details.

Polled  If Polled is chosen you will be prompted to select a polling character.  
Choices from 0 to 255.  When the polling character is received on the 
Ethernet connection, the indicator will act as if the PRINT key has been 
pressed (all of the formats-to-print will be sent out of the configured port).  
If you want the print format(s) to be sent back on the Ethernet connection, 
the print formats must be configured for tcpip1 (net1) or tcpip2 (net2).

DHCP (Dynamic Host Configuration Protocol) is a protocol for assigning dynamic IP 
addresses to devices on a network.
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Click the SMTP tab and the following is displayed:

Key in the User Name for 
the indicator.

Key in the Domain Name 
for the indicator.

Key in the email address 
for the indicator.

Key in the email recipient’s 
address.

Key in the subject of the 
email.
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3.5.4 EtherNet-2 (Modbus/TCP)

Click on EtherNet-2 (Modbus/TCP) in the drop down list to configure a EtherNet-2 
(Modbus/TCP) network. The window looks like this:

Select Indicator IP Address:
Key in the IP address for the indicator.

Download Port:
Key in the network port used to download the configuration changes via Ethernet.

Gateway:
Key in the Gateway.

Subnet:
Key in the Subnet.

Click the Map Data tab and the following is displayed:

This shows the 
“spacing” of each piece 
of data as it will show 

up on the PLC.

Click here for a 
dropdown list of 

network tokens. See 
Appendix B for full list.

Click here for a 
dropdown list of 

Data Types.

This shows the total number 
of bytes used by the indicator. 
This information is required 

by the PLC programmer and 
is automatically calculated.

Click here to 
trade/swap the

word order

Choose Endian 
Format (Big or 

Little) here.

Choose to create 
the Inbound Data 
Map or Outbound 

Data Map by 
selecting your 
choice here.

Data Type Type # Data # of Bytes Range of Value

S8 0 Signed Char. 1 -127 to 127

U8 1 Unsigned Char. 1 0 to 255

S16 2 Signed Integer 2 -32767 to 32767

U16 3 Unsigned Integer 2 0 to 65535

S32 4 Signed Long 4 -2,147,483,647 to 2,147,483,647

U32 5 Unsigned Long 4 0 to 4,294,967,295

FLOAT 6 Float 4 1.0E-37 to 1.0E37
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3.5.5 EtherNet-3 (Modbus/IP)

Click on EtherNet-3 (Modbus/IP) in the drop down list to configure a EtherNet-3 
(Modbus/IP) network. The window looks like this:

Select Indicator IP Address:
Key in the IP address for the indicator.

Download Port:
Key in the network port used to download the configuration changes via Ethernet.

Gateway:
Key in the Gateway.

Subnet:
Key in the Subnet.

Click the Map Data tab and the following is displayed:

This shows the 
“spacing” of each piece 
of data as it will show 

up on the PLC.

Click here for a 
dropdown list of 

network tokens. See 
Appendix B for full list.

Click here for a 
dropdown list of 

Data Types.

This shows the total number 
of bytes used by the indicator. 
This information is required 

by the PLC programmer and 
is automatically calculated.

Click here to 
trade/swap the

word order

Choose Endian 
Format (Big or 

Little) here.

Choose to create 
the Inbound Data 
Map or Outbound 

Data Map by 
selecting your 
choice here.

Data Type Type # Data # of Bytes Range of Value

S8 0 Signed Char. 1 -127 to 127

U8 1 Unsigned Char. 1 0 to 255

S16 2 Signed Integer 2 -32767 to 32767

U16 3 Unsigned Integer 2 0 to 65535

S32 4 Signed Long 4 -2,147,483,647 to 2,147,483,647

U32 5 Unsigned Long 4 0 to 4,294,967,295

FLOAT 6 Float 4 1.0E-37 to 1.0E37
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3.5.6 Remote I/O

Click on Remote I/O in the drop down list to configure a remote I/O network. The 
window looks like this:

Select Rack information:
Address acceptable values are 0 to 59.
Size can be 1/4, 1/2, 3/4 or Full.
Start Quarter can be First, Second, Third or Fourth.
Last can be NO or YES.

Select Remote I/O settings:
Baud Rate can be 57.6K, 115.2K or 230.4K
Remote I/O mode is Block or Cyclic

Click the Map Data tab and the following is displayed:

Valid addresses for Remote I/O 
are 0 to 59.

If an address greater than 59 is 
used, the indicator will set the 

address to 59 after the 
download.

This shows the 
“spacing” of each piece 
of data as it will show 

up on the PLC.

Click here for a 
dropdown list of 

network tokens. See 
Appendix B for full list.

Click here for a 
dropdown list of 

Data Types.

This shows the total number 
of bytes used by the indicator. 
This information is required 

by the PLC programmer and 
is automatically calculated.

Click here to 
trade/swap the

word order

Choose Endian 
Format (Big or 

Little) here.

Choose to create 
the Inbound Data 
Map or Outbound 

Data Map by 
selecting your 
choice here.

Data Type Type # Data # of Bytes Range of Value

S8 0 Signed Char. 1 -127 to 127

U8 1 Unsigned Char. 1 0 to 255

S16 2 Signed Integer 2 -32767 to 32767

U16 3 Unsigned Integer 2 0 to 65535

S32 4 Signed Long 4 -2,147,483,647 to 2,147,483,647

U32 5 Unsigned Long 4 0 to 4,294,967,295

FLOAT 6 Float 4 1.0E-37 to 1.0E37
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3.5.7 EtherNet-4 (IT Server)

Click on EtherNet-4 (IT Server) in the drop down list to configure an EtherNet-4 (IT 
Server) network. The window looks like this:

Select Indicator IP Address:
Key in the IP address for the indicator. If you enable DHCP (Dynamic Host 
Configuration Protocol), the IP address for the indicator is not required.

Download Port:
Key in the network port used to download the configuration changes via Ethernet.

Select Ethernet Addresses:
Key in the IP address for the host IP, SMTP, Gateway, Subnet and key in the port 
number that the indicator and the remote host will be connected on.

Set Socket Mode:

SMA The SMA protocol over the Ethernet connection. This is the exact same 
protocol used on the serial ports. See the Service-Serial section of the 
1080 Service Manual for details.

Polled If Polled is chosen you will be prompted to select a polling character. 
Choices from 0 to 255. When the polling character is received on the 
Ethernet connection, the indicator will act as if the PRINT key has been 
pressed (all of the formats-to-print will be sent out of the configured port). 
If you want the print format(s) to be sent back on the Ethernet connection, 
the print formats must be configured for tcpip1 (net1) or tcpip2 (net2).
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Click the SMTP tab and the following is displayed:

3.6 Saving the File

When you have finished configuring all the items you can save the file by clicking on 
the File Save button, , on the Tool Bar. This dialog box is displayed:

Type in a file name and click Save to save it to the folder of your choice. The file name 
does not need to include a file type.  E-tools will automatically save your configuration 
file as specified by the indicator choice, shown in Save as type: drop down box.

Key in the User Name for 
the indicator.

Key in the Domain Name 
for the indicator.

Key in the email address 
for the indicator.

Key in the email recipient’s 
address.

Key in the subject of the 
email.
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4 Ethernet Industrial Protocols

4.1 Ethernet IP Explicit Messaging

4.1.1 AWTX Input Point Object (Data Out)

Class Code: 64 hex

4.1.2 AWTX Output Point Object (Data In)

Class Code: 65 hex

Table 4.1  

Class Attributes Supported services for this 
attribute (hex) Data Type

NA

Table 4.2  

Instance 
Attributes

Supported services for this 
attribute (hex) Data Type Instances

03 (Value) 0E (Get_Attribute_Single) SINT, INT, DINT, 
USINT, UINT, UDINT, 

REAL (based on 
network config in 

indicator

17 - all enabled data 
items in one message.

1-16 (”out” data item x 
in indicator is bound to 

instance x)

Table 4.3  

Class Attributes Supported services for this 
attribute (hex) Data Type

NA

Table 4.4  

Instance 
Attributes

Supported services for this 
attribute (hex) Data Type Instances

03 (Value) 10 (Set_Attribute_Single) SINT, INT, DINT, 
USINT, UINT, UDINT, 

REAL (based on 
network config in 

indicator

17 - all enabled data 
items in one message.

1-16 (”out” data item x 
in indicator is bound to 

instance x)
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4.2 Ethernet IP Implicit Messaging

4.2.1 AWTX Assembly Instance for PLC Configuration

Input: 100

Output: 112

Configuration: 128

4.3 ModBus/TCP

4.3.1 Starting Register Locations for PLC Configuration

Input Read Only 30001

Input Read/Write 40001

Output Read/Write 40101

Read only values are mirrored at the Read/Write location.
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5 Downloading a Configuration File

5.1 File Transfer

After the configuration file is created and saved (previous section) you need to finish 
the process by downloading the file to the indicator.

5.1.1 RS-232 Button

Select the RS-232 serial communications port which will be used for configuration file 
upload and download. This is also the RS-232 serial communications port which will be 
used to upgrade the indicator firmware.

Indicator must be unsealed so a file can be downloaded. See the Service Manual for 
details. 
 
Each Avery Weigh-Tronix 1080 weight indicator using File Transfer MUST be 
configured through the front panel or through RS-232 serial download to activate 
Ethernet-1 (IT-Client) or Ethernet-4 (IT-Server) prior to Configuration File Transfer 
operation.
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Settings tab

Host PC (Client)
The Host PC is the computer which has E-Tools installed on it and which will upload or 
download the configuration file to the indicator.

Serial Port Drop down box which will allow the selection of the RS-232 serial 
port which e-tools will use. Available options are COM 1 to COM 
255. These options allow the selection of any internal hardware 
serial port hardware or externally connected USB to Serial 
adapters. 

 Timeout This is the time, in seconds, which any upload or download is 
allowed to begin data transfer. If timeout occurs the upload or 
download will fail and a window will show one of the errors shown 
below.
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5.1.2 Ethernet button

Settings Tab
The Settings tab contains information about the PC network and remote host 
indicators.

Local Host PC (Client)
Machine Name Machine Name, also known as Computer Name within Microsoft 

Windows, is the network name of the host computer. This setting 
is only displayed by e-tools and cannot be modified within e-tools. 

Remote Host Indicators (Servers)
Remote IP Enter the IP address of the remote server 

indicator. If there is no remote server indicator 
leave this field blank.

Subnet Mask Enter the Subnet mask of the remote server 
indicator. If there is no remote server indicator 
leave this field blank.

Network Cofiguration Options Check a box to overwrite Fieldbus 1 or Fieldbus 2 
configurations under Net Mangage. See the 
note below.

Subnet ID, Indicator Hosts, First Subnet Host, Last Subnet Host and Subnet Broadcast 
and Remote Port are filled in by e-tools when the Remote IP address and Subnet Mask 
are entered.

WARNING: This will overwrite IP address and Subnet Mask.
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5   Downloading a Configuration File

Address List tab
The Address List contains the IP addresses and Description for all of the indicators.

Indicator
New Select the NEW button to enter an IP address and Description for the 

indicator.

Add Once an IP address and device description is entered press the Add key 
to add the indicator to the Address list.

Address List
Sorted Check this box to sort the entire Address List by IP address. This will 

reorganize the Address List from lowest first octet to highest first octet.

Check the box next to the IP address to select that IP for download when using 
Address List (Selected) in the Download List.
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5.1    File Transfer

Clear Select Clear to delete the address list which is stored as a text file in the 
e-tools installation directory. When you press Clear, a second window will 
allow you to cancel the CLEAR command. Select YES to clear the entire 
file or NO to cancel.

 

Save Once all the IP addresses and Descriptions have been added to the 
Address List select the SAVE button. The Save button will write the 
Address List to the text file. This text file is opened by e-tools on 
initialization.

Edit Select an IP address from the Address List and then select the EDIT 
button. Editing allows the IP address and Description to be modified.

Delete Select an IP address from the Address List and press the DELETE button 
to remove the IP address and Description from the Address List.

Addresses are stored in C:\Program files\Avery Weigh-Tronix\ e-tools Suite\e-tools 
(E10XX)\ HOSTINFO.TXT

Save address book before exiting e-tools or Address List modifications will be lost.
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5   Downloading a Configuration File

Download List tab

Indicator(s)
Select method of download over Ethernet from drop down box. 

Host(s)

Select which method is to be used for configuration download over Ethernet.
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5.1    File Transfer

This PC(auto-Loop back) This is an internal auto–loop back test which can be used 
to check the PC Ethernet connection function. An IP 
address of 127.0.0.1 is assigned in the Download List. 
This IP address can not be modified. A configuration 
download will FAIL if this IP address is used. The PING 
function will return a PASS or FAIL to verify function of the 
network interface card (NIC).

Single Select SINGLE and an Address window appears. Enter 
the IP address of the indicator to be downloaded to and 
press the ADD button to add the IP address to the 
Download list. Multiple IP addresses may be added to the 
Download List. These IP addresses are not stored in the 
address list and will be lost when e-tools application is 
shutdown.
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5   Downloading a Configuration File

Range Select RANGE and a Start Address to End Address 
window appears. This will allow a configuration download 
to all indicators in between these IP addresses. These IP 
addresses are not stored in the address list and will be lost 
when e-tools application is shutdown.

Selecting the checkbox “Update checkboxes based on ping results” will select only 
the indicators found before download.
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5.1    File Transfer

Address List (Selected) This will add any IP address from the Address List with a 
checkmark next to it into the Download List.

Address List (All) This will add every IP address from the Address List into 
the Download List. Configuration files will be downloaded 
to all IP addresses. If the download FAILS it will be 
marked in the Results box of the Progress window as an 
ERROR.
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5   Downloading a Configuration File

Ping
Use the PING functionality to test the network connection between the PC and each 
indicator. This allows the verification of the connection before the configuration 
download is attempted.

Timeout (sec) Set the Timeout, in seconds, the PC will attempt to send and 
receive packets during the ping request. 

 

Test IP’s All Select All to ping all IP addresses in the Download 
List regardless of checkbox status.

Selected Selected will only ping the IP addresses in the 
Download List which are selected by the checkbox 
next to the IP Address.

Reset Choose Reset to clear ping results in the DELAY and TEST 
columns within the Download List. When Reset is selected a 
window will appear asking to verify clearing the ping results.

Abort Choose Abort to stop the ping test. 
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5.1    File Transfer

Ping Select Ping to initiate network diagnostics. Ping will send out a 
request to all IP addresses within the Download List. Any IP 
address which has an indicator connected, and configured 
properly, will respond to the ping request. The data from the ping 
request will be displayed in the Download List. The Ping request 
determines if the connection will PASS or FAIL. If the connection 
is a PASS, the time, in milliseconds, will be displayed in the 
DELAY column of the Download List. 

The next step in the process is downloading the finished file to your indicator.

1. Connect the PC to the indicator, which requires the configuration, via the 
chosen serial communications port on the computer.

2. Click the Download Configuration icon.

3. The following message will be displayed:

4. Verify that the indicator is turned on and in weigh mode.

5. Click Yes to download the indicator configuration.  The following screen will 
appear and the indicator will display the word bUSy.
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5   Downloading a Configuration File

6. Once the download is complete, the window will change to show a Pass or Fail 
condition.

7. Once configuration download is complete the indicator is ready to be 
calibrated.



1080 e-tools User Instructions 69

5.2    Uploading a File

5.2 Uploading a File

Configurations can only be uploaded by using an RS-232 connection. Ethernet is only 
capable of downloading new configurations to network enabled indicators.

1. To upload an indicator configuration from the indicator to E-tools, connect the 
indicator to the PC.  

2. Open the E-tools program and click the Upload Configuration button on the 
Tool Bar. 

3. The following message will be displayed.

4. Once the upload is complete, the window will change to show a Pass or Fail 
condition.

5. After uploading the indicator configuration it is recommended to save the file. 
Refer to section Saving a File for detailed instructions. The indicator 
configuration can now be viewed and edited as needs demand.

Indicator must be unsealed for a file to be uploaded from it. See the Service Manual 
for details.
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5   Downloading a Configuration File

5.3 Downloading Firmware

Firmware can be downloaded via an RS-232 or ethernet connection. See either RS-
232 Button on page 57 or Ethernet button on page 59

This item allows you to download new firmware to the indicator’s microprocessor when 
needed for proper servicing. 

1. Remove power to the indicator by unplugging it.

2. Select the Firmware tab in E-tools, then choose Download. The following is 
displayed:

3. Use the Browse button to select the desired version of firmware to download 
into the indicator.

4. Use the browser window to find and select the appropriate firmware for 
download, then click the Download button.

CAUTION: Be sure to turn off any screensavers before downloading new 
firmware or enable the “Prevent screensaver while downloading firmware” 
option in the TOOLS>OPTIONS dialog box.
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5.3    Downloading Firmware

5. Caution: The user will be warned to check all connections. The indicator uses 
flash memory, any interruption in power or communications may damage the 
flash memory.

6. Click Cancel to abort firmware download or select OK to download firmware.

7. After selecting OK, plug in the indicator and the downloading will begin.

8. While downloading firmware, a progress bar appears to indicate file download.

9. After the download is complete, cycle power on the indicator.
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Appendix A: Print Format Commands
Printing Commands Chart

Dec HEX Token Application Group Parameter

128 80 GWT(,n) Gross Weight [1] Weight OPTIONAL, (ASCII)
Range: (‘2’-‘9’), Indicator Default: ‘6’

129 81 NWT(,n) Net Weight [1] Weight OPTIONAL, (ASCII)
Range: (‘2’-‘9’), Indicator Default: ‘6’

131 83 SAT(,n) Semi-Auto Tare [1] Weight OPTIONAL, (ASCII)
Range: (‘2’-‘9’), Indicator Default: ‘6’

132 84 UN Units Weight
135 87 ID Scale Serial Number Misc
136 88 TIM,x Time Time MANDATORY (DECIMAL)

Range: (0-2), Editor Default:1
0= Format as set/active in indicator
1= hh:mm
2= hh:mm AM/PM

137 89 DAT,x Date Date MANDATORY, (DECIMAL)
Range: (0-4), Editor Default:1
0= Format as set/active in indicator 
1= MM/DD/YY
2= MM/DD/YYYY
3= DD/MM/YY
4= DD/MM/YYYY

138 8A TTV,n Target Value Trip MANDATORY, (HEX #s)
Range: (‘31’-‘33’), Editor Default: ‘1’ 
For target weights

140 8C AXL Last axle weight Vehicle
142 8E CLA(,n) Checkweigher

‘Low Accept’ value [1]
Checkweight OPTIONAL, (ASCII)

Range: (‘2’-‘9’), Indicator Default: ‘6’
143 8F CHA(,n) Checkweigher

‘High Accept’ value [1]
Checkweight OPTIONAL, (ASCII)

Range: (‘2’-‘9’), Indicator Default: ‘6’
144 90 RAV,n Active Recipe 

Ingredient x ‘Actual’ value
Recipe MANDATORY, (HEX #s) 

Range: (‘31’-‘38’), Editor Default: ‘1’ 
For target weights in recipe

145 91 RTV,n Active Recipe 
Ingredient x ‘Target’ value

Recipe MANDATORY, (HEX #s) 
Range: (‘31’-‘38’), Editor Default: ‘1’ 
For preact values in recipe

146 92 RPV,n Active Recipe
Ingredient x ‘Preact’ value

Recipe MANDATORY, (HEX #s)
Range: (‘31’-‘38’), Editor Default: ‘1’ 
For target weights in recipe

147 93 RIU,n Active Recipe
Ingredient x units

Recipe MANDATORY, (HEX #s)
Range: (‘31’-‘38’), Editor Default: ‘1’ 
For ingredient units (lb or kg for weight 
based ingredients; sec for time based 
ingredients; cnts or gallons for pulse 
counter based ingredients). To be printed 
after the target or actual ingredient value.
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Notes:

These tokens can be optionally followed by an ASCII 2 to 9 to specify the number of 
weight digits (including decimal point). If no specifier is given it defaults to 6 digits (+ 
decimal point) (equivalent to ASCII 6).

Further, parameter values may be ASCII digits (i.e. range ‘0’ thru ‘9’) or DECIMAL 
values (i.e. range 0 thru 255). In all cases, parameters consume one byte. In the term/
token table parameters are indicated as follows:

Optional, (ASCII) - (,n) 
Optional, (Decimal) - (,x)

148 94 PCE Piece Weight Count
149 95 CNT Current Count Value Count
151 97 GTO Gross Accumulator Weight
152 98 GTU Clears G, T or N Accum in print Misc.
153 99 STO Net Accumulator Weight
155 9B PLU PLU NumberData PLU
156 9C DES PLU ID PLU
162 A2 DIS Remote Display Status Miscellaneous
170 AA VER Software Version Number Miscellaneous
173 AD WST Weight Steady Weight
178 B2 PUP Tare associated with the PLU PLU
184 B8 PUT PLU Totals Information PLU
188 BC PCT PLU Count Total PLU
189 BD LST Net Accumulator PLU
190 BE LGT Gross Accumulator PLU
200 C8 DSP(,n) Print the displayed weight Weight OPTIONAL, (ASCII)

Range: (‘2’-‘9’), Indicator Default: ‘6’
215 D7 NULL Null Token Strings
216 D8 ACT Print the active value (‘G’ for 

gross, ‘N’ for net, ‘T’ for tare)
Weight

230 E6 DRT Remote display token-Axle 
mode

Vehicle

231 E7 HST Active Value-Axle mode Vehicle
233 E9 AXT Axle total Vehicle
242 F2 PWT Peak Hold Weight value Weight
246 F6 MWR Axle index Vehicle
253 FD HEX,xx Following number will be 

transmitted by value. Also, 
use this selection to 
transmit a NUL as well.

Hex-Codes MANDATORY, (ASCII-HEX)
Range: (00 – FF), Editor Default: 00

254 FE TEX Reserved for future use 
as a ‘token extender’

-----

255 FF EOS End of String String

Printing Commands Chart

Dec HEX Token Application Group Parameter
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Mandatory, (ASCII) - ,n
Mandatory, (Decimal) - ,x
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Appendix B: Network Tokens

Token Inbound
to net1

Outbound
from net 1

Inbound
to net 2

Outbound
from net 2

Token 
(dec.)

Token
(hex) Description

Gross X X 0 00 Output GROSS weight to  the network.
Net X X 1 01 Output NET weight to  the network.
Tare X X X X 2 02 Input TARE weight value from the network 

or output TARE weight to the network.
Peak X X 3 03 Output PEAK weight to  the network. Only 

used with the TOP application
Count X X 4 04 Output the piece COUNT to the network.  

Only used with the COUNT application.
PLU Piece 
weight

X X X X 5 05 Input PLU PIECE WEIGHT from network or 
output PLU PIECE WEIGHT to network.  
Allows selection of PLU for a COUNT 
application or returns the PLU PIECE 
WEIGHT to the network.

PLU number X X X X 6 06 Input PLU NUMBER from network or output 
PLU NUMBER to network

PLU Gross 
Accumulator

X X 7 07 Output PLU GROSS ACCUMULATED 
WEIGHT to network.  Used with ACCUM 
application.

PLU Net 
Accumulator

X X 8 08 Output PLU NET ACCUMULATED 
WEIGHT to network.  Used with ACCUM 
application

PLU Total 
counter

X X 9 09 Output PLU TOTAL COUNTER to network

PLU Count 
Accumulator

X X 10 0A Output PLU ACCUMULATED PIECE 
COUNT to network.  Used with COUNT 
application.

PLU Tare value X X X X 11 0B Input PLU TARE WEIGHT from network or 
output PLU TARE WEIGHT to network.

PLU ID X X X X 12 0C Input PLU ID from network or output PLU ID 
to network.  Select preconfigured PLU's 
from the network or will return the active 
PLU ID.

PLU Lower 
Target weight

X X X X 13 0D Input PLU LOWER TARGET WEIGHT from 
network or output PLU LOWER TARGET 
WEIGHT to network.  Used with 
CHECKWEIGHER application

PLU Upper 
Target weight

X X X X 14 0E Input PLU UPPER TARGET WEIGHT from 
network or output PLU UPPER TARGET 
WEIGHT to network.  Used with 
CHECKWEIGHER application

Recipe 
Ingredient 
number

X X 15 0F Output ingredient number for the selected 
recipe to the network.  Used with BATCH 
application.

Recipe 
Ingredient 
target weight

X X 16 10 Output the configured ingredient target 
weight value for the selected recipe.  Used 
with BATCH application.
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Recipe 
Ingredient 
actual weight

X X 17 11 Output the actual weight the of the 
ingredient.  Used with the BATCH 
application.

Motion/Weigher 
Steady

X X 18 12 Output to the network to determine the 
stability of the scale.  0 = MOTION  -1 = 
STABLE

Center of Zero/
zero balance

X X 19 13 Output to the network to determine if the 
scale is at Center of Zero.
0 = NOT CoZ  
-1 = CoZ

Overload X X 20 14 Output to network to determine if the scale 
has an OVERLOAD condition.
0 = Not O.L. 
1 = O.L.

Underload X X 21 15 Output to thenetwork to determine if the 
scale has an UNDERLOAD condition.
0 = Not U.L.
 1 = U.L.

Input1-3 X X X X 22 16 Trigger an indicator INPUT from the network 
or output the status of an indicator INPUT to 
the network.
Bit0 set – input1 active
Bit1 set – input2 active
Bit2 set – input 3 active

Output 1-3 X X X X 23 17 Set the OUTPUT value from the network or 
output the OUTPUT status to the network.
Bit0 set – output1 active
Bit1 set – output2 active
Bit3 set – ouput3 active

Serial number X X 24 18 Output the indicator serial number, unique 
ID, to the network.

Watchdog 
counter

X X 25 19 Output the value of the WATCHDOG 
counter to the network. Enables the 
operator to verfiy scale is functioning.

Remote zero X X 26 1A Allows the network to perform a ZERO 
operation. ZERO operation dependant upon 
indicator configuration.

Remote tare X X 27 1B Allows the network to perform a TARE 
operation.  TARE operation dependant upon 
indicator configuration.

Remote print X X 28 1C Allows the network to perform a PRINT 
operation.  PRINT operation dependant 
upon indicator configuration.

Remote 
accumulate

X X 29 1D Allows the network to perform a ACCUM 
operation.  ACCUM operation dependant 
upon indicator configuration.

Token Inbound
to net1

Outbound
from net 1

Inbound
to net 2

Outbound
from net 2

Token 
(dec.)

Token
(hex) Description
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Bridge1 X** X* X* X** 30 1E

Network BRIDGE tokens.  These allow data 
to be mapped from NETWORK#1 to 
NETWORK#2 or from NETWORK#2 to 
NETWORK#1. 
                                                                                              
*  Bridge tokens which are INBOUND on 
Net 2 can be OUTBOUND on Net 1.

 ** Bridge tokens which are INBOUND on 
Net 1 can be OUTBOUND on Net 2.

Bridge2 X** X* X* X** 31 1F
Bridge3 X** X* X* X** 32 20
Bridge4 X** X* X* X** 33 21
Bridge5 X** X* X* X** 34 22
Bridge6 X** X* X* X** 35 23
Bridge7 X** X* X* X** 36 24
Bridge8 X** X* X* X** 37 25
Bridge9 X** X* X* X** 38 26
Bridge10 X** X* X* X** 39 27
Bridge11 X** X* X* X** 40 28
Bridge12 X** X* X* X** 41 29
Bridge13 X** X* X* X** 42 2A
Bridge14 X** X* X* X** 43 2B
Bridge15 X** X* X* X** 44 2C
Bridge16 X** X* X* X** 45 2D
Indicator 
Healthy

X X 46 2E Output of 2 bytes to the network indicating any 
faults in the indicator.  When no errors, the value 
output to the network is 0xFFFF.                                                                                                 
Byte#1:                                                                                                                                                                                              
Bit#0 = Any Fault
Bit#1 = ADC Error
Bit#2 = SRAM ErroR
Bit#3 = EEPROM Error
Bit#4 = N/A
Bit#5 = Overload
 Bit#6 = Underload
 Bit#7 = N/A
Byte#2:
bit#0 - bit#7 is not used at this time.                                                                                                                      

Inmotion 
Specials

X X 47 2F

Inmotion 
Special

X X 48 30

Weight for 
Setpoint #1

X X X X 49 31 Input from network to change the weight of 
OUTPUT#1 or an output to the network to 
view the weight value of OUTPUT#1

Weight for 
Setpoint #2

X X X X 50 32 Input from network to change the weight of 
OUTPUT#2 or an output to the network to 
view the weight value of OUTPUT#2

Weight for 
Setpoint #3

X X X X 51 33 Input from network to change the weight of 
OUTPUT#3 or an output to the network to 
view the weight value of OUTPUT#3

Token Inbound
to net1

Outbound
from net 1

Inbound
to net 2

Outbound
from net 2

Token 
(dec.)

Token
(hex) Description
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Appendix C: e-tools Error Messages
1 MDF file does not exist
2 CFG file does not exist
4 Communications port close failed
5 Invalid ASCII token found when converting print formats
6 Invalid print token found when converting print formats
7 Unable to establish upload connection to indicator
8 Upload failed because of an invalid packet
9 A timeout occurred when uploading configuration

10 An error occurred when downloading configuration
11 Invalid keyword
14 Error processing file keyword line
15 Error processing parameters for  keyword
16 Error processing an ASCII token
17 Error processing a print token
18 MDF keyword parameters are invalid
19 Error reading .MDF file
20 Error reading .CFG file
21 Error writing .CFG file
22 Download error
23 Error processing structures to configuration array
24 Error processing a configuration array to structures
25 Error processing a configuration keyword line
26 Error processing configuration lines
27 Searched for an invalid print token
28 Invalid print format found processing print format parameters
29 Error processing .CFG lines
30 Error processing the first line of the .CFG file
31 Error initializing the .CFG array
32 Error saving the .CFG file
33 Error creating a packet to transmit to the indicator
34 Error processing an uploaded packet
35 Invalid print format index specified
36 Invalid hex code conversion attempted
39 Error occurred processing EMODELS.TXT file
40 No response or NAK to download packet transmission
41 Invalid print format token parameter found
42 Error processing an extended print token
43 Invalid extended print token found during conversion
44 Error when transferring a new configuration to the old format
45 Error occurred when transferring an old configuration to the new format
46 Error occurred when processing print format order
47 The ENDPFORDER was not found in the MDF file
48 Timeout occurred when waiting for indicator upload/download prompt
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